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The Latest

The most current version of Dreamweaver is MX 2004 release 7.01. If you don’t have the
update and are still running version 7.0, then you can visit
http://www.macromedia.com/support/dreamweaver/downloads updaters.html for the free
download. If you’re not sure what version you have right now, go to Help 2 About
Dreamweaver.

Creating a Web Photo Album

One great way of integrating one Macromedia product with another—for example,
Fireworks with Dreamweaver—is to make a Web Photo Album using both Fireworks and
Dreamweaver. You must have both applications installed in order to run this feature.

To accomplish this, you'll need to begin in Dreamweaver with a blank document. Select
Commands = Create Web Photo Album. A screen will come up requesting the
appropriate information for the photo album. You will need to give your album a title, tell
it where your source images are, and where the destination folder is for compilation of
the new Web folder. You'll also need to specify the thumbnail size you wish to see (I use
144x144), the number of thumbnail columns you want on your page, and the format in
which you'd like the pictures.

Lastly, you will need to check whether or not you want a navigation page for each photo.
This is a good idea for viewers who look at the full-sized photos and navigate forward
without returning to the thumbnail page. Once you've made your selections, click OK and
Fireworks will open and prepare your images. This may take a while depending on the
volume of your source folder. Dreamweaver will pop back up once Fireworks is finished
and show you your newly created page of thumbnails.

This Web Photo Album feature is a nice alternative to using Adobe Photoshop or iPhoto
on the Macintosh. It provides a quick way for you to display your photos for family and
friends in an organized, creative, and dynamic format.

Applying Templates
On one end you have templates, and on the other you have Web files (e.g. .html and .php

pages). Merge the two by fitting the elements of your file into the editable regions of
your template.

In our example, you have an editable region called “content” in your template. Any main
content goes into that area. In your file (filename.html), select Modify = Templates =
Apply Template to Page. Select the template you’d like to use as a basis for your file.
Then, connect the parts of your file with the appropriate editable region. In our case,
you’ll want your document to fit into the “content” region. Click okay and watch your
main content seamlessly fit into your specified region.
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If you want to have template-based pages, but you don’t want to go through the trouble of
designing your own templates, then the Internet abounds with pre-made template
resources. Some are free, some are not.

Dreamweaver comes with pre-built templates. To access these, File > New Page and
make sure you’re within the “General” tab. Select the Page Design (Accessible) category
and then browse the listing of options on the right. Each single mouse click on one of the
document names brings up an image of that option on the right. Select the one you like,
create the file as a template (as opposed to a document), and click Create.

Working with templates makes your site’s design more uniform and makes updating and
maintaining your site more efficient. Every time you update non-editable regions of a
template, all pages based on that template will be updated.

Creating Flash Text

If you want to have a navigation bar on your Web page, but you don't want to make all of
the buttons for the bar from scratch, then Dreamweaver's Flash Text resource will help
you make dynamic images that you can use.

Before you begin using the Flash Text feature, create a table on your Web page into
which you can insert your new buttons. If you want a horizontal navigation bar, then
create a table with five columns, one row, five pixels of cell padding, no cell spacing, and
a border of zero. If you want a vertical navigation bar, then make sure you invert the row
and column values above.

Place your cursor in the first cell and go Insert = Media = Flash Text. You’ll have a
bunch of choices for customizing your flash text. Select the font you'd like to use, type
the text for your button, select the font and font size, add a link, and click OK. If you
don’t have some of your items ready—Ilike you don’t have pages to link to yet—then you
can simply leave it blank for now. Double-click on the item when you’re ready to come
back to it and edit.

Please note that in creating Flash Text, a Flash item (*.swf) will be saved along with your
page. This item (and all other Flash items accompanying other buttons you may
create) must be in each of the directories using them and must be uploaded along
with your page in order to function properly once your page is live. Move to each
table cell and repeat the above to create a navigation bar that links to each of your desired

pages.

Color Matching

Have you ever wanted your Web page background to match the background of an image
that you're including on your page? Dreamweaver makes this kind of color matching very
easy.

Go to Modify = Page Properties and click once on the shaded square next to the
Background option. Notice that your cursor turns into an eyedropper. Move your mouse
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to the color that you'd like to match and click once on that color. Notice that your
background color now is set to that color, down to the shade.

Adding Video

Alas, there you are on your Hawaiian vacation and you'd like all of your friends and
family to see your pictures without having to fumble through slide after slide in that Web
Photo Album. So you've converted your pictures into a slideshow (using iPhoto, for
example) and now you need to upload the file to a Web page so that others have viewing
access.

Dreamweaver makes adding video to a Web page very simple. To begin, choose Insert >
Media = Plugin. Select the movie file you want to use. (Very important: your file must
have a *.mov extension.) With the item still selected, go to the Property Inspector and
select a size for your movie display window. I normally use 640x480, but it depends on
whatever size parameters your original movie file was set to. In the Plg URL box, type
http://www.apple.com/quicktime so that those trying to view your movie without
QuickTime will be directed to the Apple Web site for downloading the application.

You can set more parameters for your movie by pressing the Parameters button in the
Property Inspector. Some useful parameters and corresponding values you might want to
use are:

* Autoplay (value: true) means your movie will start playing as soon as the page
loads. If you want the viewer to press play when the page loads, then set the value
to false instead.

* Cache (value: true) will allow your movie to be stored in the cache so that it does
not need to be reloaded with each viewing. This saves bandwidth, and your
Webmaster will thank you!

* Loop (value: true) causes your movie to restart continuously after each viewing.

* Volume (value: 0-100) sets the volume of your movie from softest (zero) to
loudest (one hundred).

Optimizing Your Code

Checking Links Sitewide

Dreamweaver allows you to make certain that internal links are functional before you
publish your site. Should you have any errors, Dreamweaver will tell you where so that
you can make corrections and changes. Better that Dreamweaver tells you rather than a
site visitor!

Please note, Dreamweaver unfortunately cannot verify broken external links, that is,

links that point outside of the current site. For this, there are other tools that can help
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such as W3C Link Check, which is a free Web-based link checker
(http://validator.w3.org/checklink).

Dreamweaver will allow you to check for both broken links (links that don't work when
your site is live) and orphaned files (files in your site that don't have anything linked to
them).

To try this on your site, go to Site = Check Links Sitewide.

Checking Links Per Page

Dreamweaver also allows you to check for broken links on a single page rather than an
entire site. This is useful for quickly verifying that your links are functional without
having to upload your Web page (along with any related materials).

To try this, go to File 2 Check Page - Check Links

Clean up Word HTML

If you've ever created a Web page in Microsoft Word and then actually looked at the
HTML code behind it, then you know that Word inserts a few hundred unnecessary lines
of code for every HTML tag. This slows down your page tremendously, since browsers
read code from top to bottom and it will take a while for the browser to read through the
unnecessary additions. To delete all of this unwanted junk without having to manually go
in and edit the code, use the Clean Up Word HTML feature in Dreamweaver.

Open your Word document saved as HTML in Dreamweaver. Then, select Commands =
Clean Up Word HTML. Work from the basic menu and select the version of Word you
are using as well as the exact attributes you would like to clean up. It's good to leave
everything checked, but if not, always make sure to leave the first option checked at
minimum, which is to remove all Word specific mark up. You'll have cleaner code and
your Web page viewers will thank you when they see how quickly your page loads!

Clean up HTML/XHTML

This feature is similar to Clean up Word HTML, but it focuses on cleaning up extraneous
HTML code. Using this feature might be helpful if you’re moving a site previously
designed in Microsoft FrontPage into Dreamweaver. Programs like FrontPage normally
tend to add globs of extra unnecessary code to your files, and running Clean up HTML
will take care of this problem and make your code as light as possible. You’ll find that
your pages load faster, since the browser doesn’t have to work as hard to load your pages.

Common things this command fixes are: empty tags, redundant nested tags, HTML
comments, or any specific tags. For example, you might want to run this command to

eliminate the unnecessary <font> or <span> tags.

To use this command, select Commands = Clean up HTML
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Unfortunately this feature only works on a page-by-page basis. However, you can run a
site report (Site = Reports) which can help identify pages with common problems and
narrow down the number of pages to clean.

Cascading Style Sheets

Templates, tables, and layouts are all cool, but cascading style sheets are cooler. Every
publication, whether it's electronic or paper-based, needs some sort of balance between
style and content in order to be effective. Cascading style sheets help streamline your
content while enhancing and designing the underlying style—such as backgrounds, text
sizes and weights, and borders. No tables, bordered cells, or heavy HTML needed!

Some sites are built completely upon CSS nowadays. Check out Wired News
(http://www.wired.com), ESPN (http://www.espn.com), and Playlist Magazine
(http://www.playlistmag.com) for some examples. Another site, CSS Vault
(http://www.cssvault.com), has a directory of sites done with CSS.

The key components behind css are selectors. A selector defines when a browser defines
a style. For example, when the selector is p (for the <p> tag), the rule you specify will be
applied to every <p>tag. You can create a CSS document, add the styles to the selectors
you want to modify, and then apply the style sheet to your pages when you are ready.

In edit mode of the CSS panel (accessible via the Window menu), begin defining how
you want to use CSS. One fun use of CSS is to change the way a link looks when moused
over. For this, you’ll have to modify the link (<a>) tag.

Create a new style and check off the "Use CSS Selector" option. In the Selector area,
choose "a: hover" and name the style (filename.css) after clicking OK. You will be
presented with a style definition wizard to select the parameters for your newly created
style. For a:hover, I usually like to set the decoration to none and then choose a grayish
background color for the link. When live, the link will be lightly colored and not
underlined when the mouse rolls over it. It will look like a standard link at all other times.

Extension Treasures

If there is a Dreamweaver function that you wish you could modify a bit, or if there's a
feature that you don't see in your usage of the application at all, then check out the
extensions library on Macromedia's Exchange site for free programs that help you modify
Dreamweaver to your liking. There are a lot of free extensions available, but there's a
price to pay for some higher level ones that really enhance your usage of Dreamweaver.

I'll demonstrate one example. Keep in mind that extensions are their own little programs
so this won't be true of all extensions, but it will give you some idea of what's possible by
using them. Your Extensions Manager will give you instructions along with each item
you download.

One simple downloadable extension from Macromedia Exchange is called Mail Spam
Blocker. This allows you to hide e-mail addresses in the code of your document,
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meaning crawlers and robots rumaging the Web for valid e-mail addresses to spam will
come up short when it comes to your pages.

Download this particular extension from the Macromedia Web site. Once installed, you'll
see a new menu in Dreamweaver if you visit Insert 2 Mail Spam Blocker. You’ll need
to input the e-mail address that you wish to hide and click OK. If you look at the source
code behind this address, you’ll see that the usual “mailto:email@address.com” format is
not there. The e-mail address, however, still functions properly when you double click
on it in a browser in order to send the person a message.

Cloaking

Have you ever stored Microsoft Word or Adobe Photoshop files in your sites folder but
they're not files that you wish to upload to the server? Fine: just cloak them, and you can
still store them in the sites folder (where they're handy in case you need to refer to them)
but they won't cause you problems when you're uploading your entire site. You also
won’t have to worry about those large image files taking up too much space on the
remote server.

Cloaked files will be in your site’s folder, yet they will be completely ignored by the
uploader when you are putting files to the remote site.

To cloak, right click the file or folder in the Files panel and select Cloaking = Cloak. A
red slash will then appear on the file or folder you have chosen. To uncloak, right click
once again on the file or folder that you wish to uncloak and select Cloaking = Uncloak.

Select Recently Modified

This is a great feature hidden away in Dreamweaver MX 2004. It lets you select files
you’ve modified during a particular period of time, or for the past number of days. Itis a
great way to select a bunch of files you’ve modified for uploading to the Web server
without having to go one by one or uploading the entire site.

To use this feature, go to the Files Panel = right-click on the root site folder = Select
Recently Modified. You can select criteria here and then upload any files modified
within your specified timeframe.

Linking by Pointing

Rather than browsing for a file or typing in a file name, Dreamweaver provides an
alternative method to creating links by allowing the Web designer to point to a file that
needs to be linked. This feature will take care of the relative link to another file in your
account so that you don’t run the risk of mistyping or mislinking it by hand.

To begin, make sure your Property Inspector is open beneath your page and that your site
panel is open in the right-hand portion of your screen. Highlight a piece of text that you
would like to link, locate the small Point-to-File icon in the Property Inspector, click
once, and drag your mouse to the file that you would like to link. Your cursor will drag a

Macromedia Dreamweaver 6 ITS
Tips and Tricks USD



line from the Point-to-File icon to the link that you select to visually demonstrate that you
are linking that file.

Adding Image Descriptions

Not everyone is going to be using a graphical Web browser to view your Web page.
Think of those using lynx, for example, who see nothing but textual Web pages. For these
people, graphical images are not an effective means of communication. That is why you
must insert an image description, normally designated by an alt tag, along with each of
your images.

To insert an alt tag, simply insert an image and with the image still selected, type a word
or two of text into the alt text window in the Property Inspector. Then, when your graphic
loads on the Web, your text will appear whenever you move your mouse over the image.
More importantly, the text will appear in place of the image in the event that the page is
not being viewed in a graphical Web browser.

This feature is also useful for assisting the visually impaired. For those who have their
Web browser set to speak Web contents to them, the alt tag is what the computer will
read. Obviously, if you have not set your images to have descriptions, then there will be
nothing to read, meaning that some of your Web site visitors will not be able to get the
full benefit of your page.

Behaviors

Technically speaking, a behavior in Dreamweaver is the combination of an action and an
event. You do something such as click a link (the action) and a new window pops up (the
event) as a result. By adding behaviors, you add both HTML and JavaScript to your Web
page, meaning content will be dynamically enhanced as a result. A standard linked
image, for example, might result in a different image when you mouse over it. This is
dynamic and functional at the same time.

There are four steps to adding a behavior: picking a tag (one tag may harbor several
behaviors), choosing target browsers in which you want the behavior to function,
selecting an action, and entering the parameters of the behavior. One downside of
behaviors is not all browsers will be able to carry out all behaviors, and the browser that
you select in Dreamweaver in your Behaviors panel is the browser for which your
behaviors will be shown.

Dreamweaver makes adding behaviors ranging from time-stamping to rollovers very easy
and convenient. And that's just the beginning. The behaviors that you'll see available
depend upon what browsers you're targeting as well as whether you're trying to enhance a
graphic or text.

Use the Behaviors panel accessible from the Window menu to start experimenting with
some possibilities. Other behaviors you can apply (for 4.0 and later browsers) include the
following:
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* Set Text of Status Bar sets the status bar to read text of your choosing while
page is loaded in the browser

* Open Browser Window displays content in a new window set to your
specifications.

*  Popup Message shows a quick message to your viewers in a pop-up window.

* Swap Image sets one image to change once another image on the page is moused
over or clicked.

Meta Tags

On their own meta tags are a simplistic concept, but when you combine them with some
neat tricks, you can make sure that your Web pages are better cataloged by various search
engines—or not at all—depending on the visibility you wish your site to have.
Dreamweaver has several meta tag menu items that can help you catalog your page to the
extent that you would like.

To begin adding meta tags to the head portion of your Web page, select Insert > Head
Tags = Meta. You will see areas for inputting a value and content. For value, insert
"Author" and for content, insert your own name. This is a meta tag that I find useful,
since it includes your name in the code in case your source code is ever stolen. Another
useful tag usage concerns robots, which travel around Web sites and index content. If you
don't want your page being indexed at all, then use "Robots" as your value and insert "no
index, no follow" as your content. This means that when robots come across your page,
they are instructed to leave without cataloging it for search engine use.

If you do want your page to show up in search engine queries, then select Insert =
HTML - Head Tages and start inputting keywords that pertain to the content of your
Web site. Your site will be indexed according to these keywords and will score higher in
search engine queries pertaining to your subject.

Find and Replace

Find and replace is the most overlooked power tool in Dreamweaver. There are four
types of find and replace: source code, text, advanced text, and specific tags. We’ll
review two of these here.

Source Code and Text Searches

Source code find and replace searches all characters in the file including tags, JavaScript,
and any server-side programming.

Text searches only look for text that appears in the body of the page (i.e. content) and not
in any of the tags. It will not search the title of the page (within the <title> tag) nor will it
search inside tags so something like the alt attribute of the image tag is not searched. It
also won’t affect HTML tags, so searching for the word “table” won’t find—or change —
any table tags.
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Advanced Text Searches

Advanced text searches allow you to find text that’s enclosed by a specific tag. You can
narrow down the search by specifying certain properties of the tag. This feature also lets
you search within the <head> as well as the <body> of the document.

Keyboard Shortcuts

Keyboard shortcuts can make your workflow much more efficient in any application you
are using. Some of the following are the shortcuts for steps you’d routinely take in
Dreamweaver.

* Preview in browser: F12 for primary browser, Control-F12 for secondary
browser

* Cycle through open documents: Control-Tab

*  Cycle between design and code views: Control-~

* Insert image: Control-Alt-i

* Insert table: Control-Alt-t

* Insert link: Control-1

You can also make your own keyboard shortcuts. To do this, go to Edit 2 Keyboard
Shorts. To begin, select the item you wish to change. Type the new keyboard shortcut
name into the “Press Key” box. Dreamweaver will list any other command that might
already use that name, if any. If the name’s not already taken, then press the Change
button to save your new shortcut.
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